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REGIONALIZAGAO DE VAZOES NA BACIA HIDROGRAFICA DO RIO PIQUIRI

RESUMO

O objetivo deste trabalho foi regionalizar as vazées minimas com sete dias de duragéo,
média anual de longa duragdo, maxima e vazdes de permanéncia de 90 e 95% da bacia
hidrografica do Rio Piquiri - PR. As vazbes maximas foram regionalizadas associadas a um
periodo de retorno especifico (2, 5, 10, 25, 50 e 100 anos) e a minima com duragao de sete
dias foi associada ao periodo de retorno de 10 anos. Para representar as séries de vazbes
maximas e minimas foram utilizadas as distribuicbes de probabilidade de Pearson tipo llI,
Log-Normal a dois e trés parametros e Log-Pearson tipo Ill, Gumbel (apenas para maximas)
e Weibull (apenas para minima). A distribuicdo Log-pearson tipo Ill obteve em 100% dos
casos, 0 menor erro padrdo, apresentando-se com o melhor ajuste aos dados de vazéo
minima. Cerca de 70% dos dados das estagbes apresentaram o menor erro padrdo quando
ajustadas a esta distribuicdo Log-Normal a trés parametros. Desta maneira a distribuicao
Log-Normal a trés parametros, foi adotada de forma padréo para as vazdées maximas, porém
as estagdes 64765000 (Porto Paiqueré), 64771500 (Porto Guarani), 64785000 (Ponte do
Goio-Bang) que nao obtiveram ajuste a esta distribui¢ao, utilizou a distribuicao Log-Normal a
dois parametros. A vazao média de longo periodo, por ser caracterizada como a média das
vazdes médias anuais, foi regionalizada sem considerar o nivel de risco. Para a obtencao da
curva de permanéncia realizou-se o procedimento baseado na obtencdo de classes de
frequéncia. No procedimento de regionalizagdo foram empregados: o método Tradicional
descrito por Eletrobras (1985a), o método de Interpolagao linear (ELETROBRAS, 1985b), o
método de Chaves et al. (2002), Interpolagéo linear modificado e Chaves modificado
(NOVAES et al., 2007). Como variaveis explicativas, para o método Tradicional, foram
utilizadas as caracteristicas fisicas: area de drenagem; o comprimento do rio principal;
declividade média da bacia; declividade média do rio principal; densidade de drenagem, e as
caracteristicas climaticas: precipitacao total anual; precipitacdo do trimestre mais chuvoso;
precipitacao do trimestre mais seco. Os modelos de regressao que melhor se ajustam aos
dados de vazao séo o potencial simples e o potencial multiplo. A area e a densidade de
drenagem sao as melhores variaveis explicativas para a estimativa da vazado minima com
duragdo de sete dias e periodo de retorno de dez anos (Q7.10). O comprimento do rio
principal € a melhor variavel explicativa para a estimativa das vazées com 90 e 95% de
permanéncia (Qg e Qgs, respectivamente). A area e a densidade de drenagem sao as
melhores variaveis explicativas para a estimativa da vazao minima com duragcado de sete
dias e periodo de retorno de dez anos (Qy7,10), © comprimento do rio principal e a érea para a
estimativa das vazdes com 90 e 95% de permanéncia (Qq € Qgs, respectivamente) e o
comprimento do rio principal € a melhor variavel explicativa para a estimativa das vazoes
maximas considerando todos os periodos de retorno estudados. O método da interpolagcao
linear faz estimativas semelhantes ao método Tradicional e pode ser utilizado em situacoes,
principalmente quando ndo ha informagdes suficientes para o ajuste dos modelos de
regressdo. As estimativas das vazdes minimas (Q71, Qo € Qgs) € vazdo média (Qmeaq),
realizadas pelo método de Chaves sao semelhantes ao Tradicional, enquanto que as
estimativas das vazdes maximas, para todos os periodos de retorno estudados,
apresentaram erros muito elevados. Os métodos modificados ndo promoveram a melhora
expressiva das estimativas em comparagcdao com os métodos originais.

Palavras-chaves: método tradicional, método interpolagao linear, método de Chaves.
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FLOW REGIONALIZATION OF THE PIQUIRI RIVER BASIN
ABSTRACT

The objective of this research was to regionalize the minimum seven-day flows, annual
average long-term duration, maximum and permanence flows of 90 and 95% of the
catchment area of the Piquiri River - PR. The peak flows were regionalized associated with a
specific return period (2, 5, 10, 25, 50 and 100 years) and the minimum flow lasting seven
days was associated with a 10-year return period. To represent the series of maximum and
minimum flows probability Pearson type Il distributions, two- and three-parameter Log-
normal and type Il Log-Pearson, Gumbel (for maximum flows) and Weibull (for minimum
flows only) were used. Type lll Log-Pearson distribution obtained in 100% of cases, the
lowest standard error, presenting the best adjustment with the minimum flow data. About
70% of the data stations showed the lowest standard error when adjusted to this three-
parameter log-normal distribution. Thus, the three-parameter Log-Normal distribution was
adopted as default, but stations 64765000 (Porto Paiqueré), 64771500 (Porto Guarani),
64785000 (Goio Bang Bridge), which did not obtain adjustment with this distribution, used
the two-parameter Log-Normal distribution. The period average flow, once it is characterized
as the average of the annual average flow, was regionalized without considering the risk
level. In order to obtain the permanence curve, the procedure based on obtaining the
frequency classes was carried out. In the regionalization procedure the following methods
were employed: the traditional method described by Eletrobras (1985a), the linear
interpolation method (ELETROBRAS, 1985b), the method proposed by Chaves et al. (2002),
the modified linear interpolation and the modified Chaves (NOVAES et al., 2007). As
explanatory variables for the traditional method, the following physical characteristics were
used: drainage area; the length of the main river; the basin mean land slope; the mean land
slope of the main river; drainage density, and climatic characteristics: the total annual rainfall;
the precipitation of the wettest quarter; the precipitation of the driest quarter. The regression
models that best fit the flow data are the simple potential and the multiple potential ones. The
area and the density drainage are the best explanatory variables for the estimate the
minimum seven-day flow and ten-year return period (Q7 1). The length of the main river is the
best explanatory variable for the estimate of flow rates of 90 and 95% of permanence (Qg
and Qqgs, respectively). The area and the drainage density are the best explanatory variables
to estimate the minimum seven-day flow and the ten-year return period of (Q7 1), the length
of the main river and the area for the flow estimate with 90 and 95% of permanence (Qq and
Qgs, respectively) and the length of the main river is the best explanatory variable for the
estimate of maximum flows considering all return periods studied. The method of linear
interpolation produces similar estimates to the ones obtained with the Conventional method
and can be used in situations, especially when there is sufficient information for adjustment
of the regression models. Estimates of minimum flows (Q7.10, Qg0 and Qgs) and of average
flow (Qmeq), performed by using the Chaves method are similar to the ones obtained with the
Conventional method , while the estimates of peak flows for all return periods studied,
presented major errors. The modified methods did not promote significant improvement of
the estimates compared to the original methods.

Keywords: traditional method, linear interpolation method, Chaves method.
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1 INTRODUGAO

O conhecimento das vazdes é extremamente importante para o planejamento e
gestdo dos recursos hidricos, pois, auxilia em projetos de barragens e construgdes
hidrelétricas; na avaliagdo da disponibilidade de agua para irrigacao e outros usos da agua;
na avaliagcao de riscos de cheias e secas e outras preocupagoes (MASIH et al., 2010).

Um dos instrumentos adotados na Lei n° 9.433/97, para dar suporte a gestdao dos
recursos hidricos € a outorga dos direitos de uso de recursos hidricos, condicionada a uma
percentagem da vazdo minima de referéncia, a qual varia de acordo com o regime e a
jurisdicdo do rio. Em rios de regime permanente ou rios perenes a outorga é usualmente
feita com base na vazao minima com duracéo de sete dias e periodo de retorno de 10 anos
(Q7.10) 0ou, nas vazdes minimas associadas as permanéncias de 90% e 95% no tempo (Qgo €
Qgs, respectivamente), atribuindo-se valores percentuais a elas, ou seja, outorgando-se
apenas parcelas das vazdes minimas de referéncia (FERREIRA, 2010).

Neste ambito de gerenciamento, é importante também a determinacdo da vazao
média, a qual auxilia usuarios e 6rgaos gestores no estudo da possibilidade de implantagao
de reservatérios de regularizagdo, como alternativa para solucionar problemas de
quantidade de agua e atender aos usos multiplos (ALMEIDA, 2010). Ja o conhecimento da
vazao maxima, além de ser utilizado em estudos basicos de projetos e implantagao de obras
hidraulicas, pode ser usado como instrumento de gestdo, uma vez que é essencial o
conhecimento de sua frequéncia, visto que é causadora de enchentes, que trazem impactos
negativos para a sociedade como perdas econbémicas, danos ao desenvolvimento e, até
mesmo, perdas de vidas humanas (ARAUJO, 2008).

No Brasil, ainda existem regides sobre as quais os dados hidrolégicos basicos sao
reduzidos ou inexistentes, devido aos elevados custos de implantacdo, operacdo e
manutencdo de uma rede hidrométrica, principalmente em grandes bacias. Além disso,
muitos postos hidroldgicos tém dados de poucos anos, que ndo compdem uma amostra
representativa sobre a vazdo (CASTRO; RUHOFF, 2009). A falta de dados para estimar as
vazdes em bacias hidrograficas € um problema fundamental para o planejamento e gestao
dos recursos hidricos e um grande desafio para a comunidade cientifica (LI; SHAO; ZHANG,
2010).

A regionalizagdo vem sendo utilizada para superar esta falta de dados hidrolégicos
em lugares onde ha pouca ou nenhuma informacéo disponivel (SAMUEL; COULIBALY;

METCALFE, 2011). A técnica da regionalizacdo visa transferir informagdes das regides
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monitoradas para as areas carentes de dados. Além disso, o estudo possibilita a
identificacdo de areas que necessitam de melhoria da rede hidrometeoroldgica.

Diversos métodos tém sido testados e utilizados, em inumeros estudos hidrolégicos
realizados, tanto em ambito nacional quanto internacional. Almeida (2010) relata que os
métodos tém buscado agregar caracteristicas hidrolégicas a analises estatisticas,
procurando uma forma mais objetiva de obter Equagdes que possam ser aplicadas a uma
determinada regido.

Em 1985, a Eletrobras em parceria com o instituto de Pesquisa Hidraulicas — IPH, da
Universidade Federal do Rio Grande do Sul, sob a orientagdo e coordenagdao do
Departamento de Recursos Energéticos — DEEN, divulgou um guia metodologico para
regionalizacdo de vazdes, no qual apresenta os procedimentos, passo a passo, para
elaboragédo da regionalizagdo. O objetivo geral do guia foi estabelecer uma padronizagao
desse procedimento (ELETROBRAS, 1985a). O método ficou conhecido como método
tradicional (MT) ou método da Eletrobras, e que consiste em duas etapas: 1) identificagcao
de regides hidrologicamente homogéneas; 2) ajuste de equagdes de regressao, entre as
variaveis a serem regionalizadas e as caracteristicas fisicas e climaticas das bacias de
drenagem, para cada regido homogénea.

Entretanto, quando as bases de dados disponiveis em uma bacia hidrografica sao
reduzidas, a regionalizacao de vazdes por esse método apresenta grandes restricdes. Como
a maioria das bacias hidrograficas brasileiras possui escassez de informagdes, a precisdo e
0 uso deste método de regionalizagdo pode se tornar ndo recomendavel (NOVAES, 2005).

Algumas metodologias tém sido desenvolvidas de modo a superar esta limitacao.
Dentre elas, destacam-se: a metodologia baseada na interpolagdo linear descrita pela
Eletrobras (1995b), o método proposto por Chaves et al. (2002) e as modificagdes propostas
por Novaes et al. (2007).

Visto que a Bacia Hidrografica do Piquiri possui uma area total de 24.156 km? (IAP,
2008), em torno de 12% da area do estado do Parana (PARANA, 2013), banhando
totalmente ou parcialmente 68 municipios (IAP, 2008) com uma populagédo de 609.473
habitantes (IBGE, 2004) cerca de 6% do total do estado (PARANA, 2013), este estudo teve
como objetivo analisar e comparar os diferentes métodos de regionalizagdo de vazdes na

bacia hidrografica do Piquiri.



2 OBJETIVOS

21 Objetivo geral

Comparar diferentes métodos de regionalizagdo de vazdes para a bacia hidrografica
do rio Piquiri, no estado do Parana: método tradicional (Eletrobras), método da interpolacao
linear, método de Chaves, método da interpolacao linear modificado, e método de Chaves

modificado.

2.2 Objetivos especificos

- Dentre as variaveis fisicas e climaticas, definir qual melhor explica as vazbes
minimas (Q710 Qg € Qgs), a vazdo média (Qmeq) € as vazdes maximas (Qusx) para os
periodos de retorno de 2, 5, 10, 25, 50 e 100 anos;

- Definir o modelo de regresséao (linear, potencial, exponencial ou logaritmico) que

melhor se ajusta aos dados, no emprego do método tradicional.



3 REVISAO BIBLIOGRAFICA

3.1 Gestao de recursos hidricos

A disponibilidade de agua doce para o consumo humano é um dos maiores
problemas ambientais do mundo. Em face da iminente situacdo de escassez de agua,
ocasionada pela poluicdo dos recursos hidricos, emerge uma nova forma de gestao pautada
no planejamento e manejo desse recurso de forma integrada, participativa e descentralizada
(MELO et al., 2010).

A existéncia de problemas sérios relacionados a disponibilidade de agua para a
humanidade foi apontada formalmente na Conferéncia Internacional de Agua e Meio
Ambiente, em Dublin, Irlanda, em 1992, quando representantes de 100 paises e 80
organismos internacionais, intergovernamentais e nao governamentais reuniram-se e
diagnosticaram que a situagdo futura dos recursos hidricos no mundo era critica (ICWE,
1992).

Na ocasido, foram estabelecidos quatro principios para a gestdo sustentavel da
agua, assim sistematizados: i) a agua doce € um recurso finito e vulneravel, essencial para a
manutencao da vida, para o desenvolvimento e para o meio ambiente; ii) seu gerenciamento
deve ser baseado na participacao dos usuarios, dos planejadores e dos formuladores de
politicas, em todos os niveis; iii) as mulheres desempenham papel essencial na provisao, no
gerenciamento e na prote¢do da agua; iv) o reconhecimento do valor econbmico da agua
(ICWE, 1992).

Em seguida, os principios de Dublin sobre a agua foram referendados na
Conferéncia das Nacdes Unidas para o Ambiente e Desenvolvimento (Cnumad), também
conhecida como Rio — 92 ou Eco — 92, realizada no Rio de Janeiro em 1992. Entre os varios
documentos produzidos, o de maior importancia foi a Agenda 21, apesar de ser tratada em
diversos capitulos do documento, a questao dos recursos hidricos é especificada no capitulo
18, no qual sado propostos programas de agodes referentes as aguas doces (ONUBR, 1992).

Em 1997, ocorreu o 1° Férum Mundial da Agua, em Marrakesh, Marrocos. Na
ocasi&o, o Conselho Mundial da Agua foi incumbido de preparar o trabalho intitulado: “Visdo
sobre a Agua no Mundo, Vida e Meio Ambiente no Século XXI”. Também foram
estabelecidas as bases para a criagdo da Comissdo Mundial sobre a Agua no Século XXI e
estrutura para Agao e a Parceria Global da Agua (MELO et al., 2010).

Nesse contexto, no Brasil, em 8 de janeiro de 1997, por meio da Lei n° 9.433 foi

instituida a Politica Nacional de Recursos Hidricos o qual tem como objetivos:
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| - assegurar a atual e as futuras geracdes a necessaria disponibilidade de
agua, em padroes de qualidade adequados aos respectivos usos;
Il - a utilizagdo racional e integrada dos recursos hidricos, incluindo o
transporte aquaviario, com vistas ao desenvolvimento sustentavel,
Ill - a prevencao e a defesa contra eventos hidrolégicos criticos de origem
natural ou decorrentes do uso inadequado dos recursos naturais (BRASIL,
1997, p. 15).

A Lei n° 9.433/1997, por seu carater inovador, constitui-se em uma das mais
modernas e arrojadas propostas de gestao publica das aguas no Brasil, apresentando-se
como ponto de convergéncia dos principios da Agenda 21 e representando um marco
histérico para a implementacdo do sistema de gestdo integrado e participativo no Brasil
(ANA, 2012).

Nesse sentido, o conhecimento das vazdes € extremamente importante e possibilita
o planejamento e a gestao dos recursos hidricos (MASHI et al., 2010). As vazdes maximas,
médias, minimas e a curva de permanéncia, entre outras aplicacdes, possibilitam avaliar a
disponibilidade hidrica de uma bacia hidrografica, estimar os riscos de inundagdo e o
dimensionamento de obras hidraulicas para o controle de enchentes e, ainda, auxiliam no

estudo da implantagao de reservatérios regularizadores etc.

3.2 Vazao maxima

A vazdo maxima de um rio é entendida como sendo um valor de vazao associado a
um risco de ser igualado ou ultrapassado (SANTOS, 2010). E utilizada na prevencdo de
enchentes e no projeto de obras hidraulicas, tais como canais, bueiros, vertedores de
barragens, galerias de aguas pluviais e sistemas de drenagem (PRUSKI; PRUSKI, 2011).
Segundo Araujo (2008), a seguranga de qualquer uma dessas obras depende da preciséo
e/ou da confiabilidade da vazdo maxima, também entendida como vazéo de projeto ou de
dimensionamento.

Os valores das vazdes de projeto, para dimensionamento das estruturas hidraulicas,
sao associados a tempos de retorno notaveis que, por sua vez, sdo estabelecidos em
funcdo de riscos, porte da obra, localizagdo e cronograma de construgdo (TUCCI, 2009).
Deve-se definir o risco de um projeto de acordo com os objetivos do projeto.

Segundo Tucci e Mendes (2006), a vazdo maxima pode ser estimada a curto ou
longo prazo. A estimativa em curto prazo é feita por meio do acompanhamento de um
evento resultante de uma precipitacdo em tempo real. A previsdo em longo prazo é
alcancada por meio da previsao estatistica da vazdo maxima (diaria ou instantidnea) em

qualquer ano.



3.3 Vazao média de longo periodo

Segundo Pruski e Pruski (2011), a vazdo meédia permite caracterizar a
disponibilidade hidrica potencial de uma bacia sendo, a maior vazao possivel de ser
regularizada no curso d’agua, abstraindo-se as perdas por evaporacao e infiltracdo. Os
autores explicam que a vazao média de longa duragao relaciona-se com a disponibilidade
potencial e, para a adequada gestdo dos recursos hidricos, € necessario, tal como na
gestdo de um orgcamento doméstico, conhecer essa disponibilidade (natural e potencial) de
agua a fim de compatibiliza-la com as demandas ja existentes e futuras.

Para calcular a vazdo média de longo periodo, utiliza-se a média aritmética dos
valores de vazdo médios diarios (WOLFF, 2013), visto que a probabilidade de ocorréncia
dessas vazdes médias € pouco utilizada em projetos hidrolégicos, mas pode ser utilizada
para indicar os limites de variacdo dentro de determinados riscos, caracterizando a
variabilidade anual (TUCCI, 2002).

34 Vazao minima

A disponibilidade natural de agua na hidrografia pode ser avaliada pela analise das
vazdes minimas observadas nos periodos de estiagem, refletindo o potencial disponivel
para o abastecimento de agua para populagbes, industrias, irrigacdo, navegacao,
dessedentacdo animal, langamento de poluentes e outras atividades, sem que lhes seja
necessaria a regularizagao de vazao dos cursos d’agua (PRUSKI; PRUSKI, 2011).

Na pratica pouca utilidade tém as vazbes minimas instantdneas, que devem ser
muito préximas da vazao minima diaria. Normalmente duracdes maiores, como sete dias,
apresentam maior interesse ao usuario, pois a sequéncia de vazbes baixas €& que
representa uma situacdo desfavoravel para a demanda ou para as condigbes de
conservacao ambiental (TUCCI; MENDES, 2006).

Apesar da diversificacdo dos critérios utilizados para avaliagcdo dos pedidos de
outorga, tem-se adotado pelos 6rgéos gestores a Q719 (ANA, 2007a). A Q1o corresponde a
vazao minima com sete dias de duragédo e tempo de retorno de dez anos, ou seja, a cada
dez anos, em média, ha o risco de ocorrerem sete dias seguidos com esta vazdo minima
média (FIOREZE; OLIVEIRA; FRANCO, 2010).



3.5 Curva de permanéncia

Nem sempre o interesse do usuario de agua esta voltado para o conhecimento das
vazdes médias, maximas ou minimas. Muitas vezes, o interesse consiste em conhecer a
amplitude de variagdo das vazobes e, principalmente, a frequéncia com que cada valor de
vazao ocorre em determinada secao do curso d’agua. A resposta para essa questdo é
obtida por intermédio da determinagéo da curva de permanéncia (LEMOS, 2006).

A curva de permanéncia de vazdes é a relagéo entre as vazdes diarias de um ponto
num trecho do rio e a frequéncia em que elas sao igualadas ou superadas, permitindo
estimar a probabilidade de excedéncia das vazbes no tempo. Esta curva retrata as
caracteristicas de regularizagdo natural do rio e, geralmente, apresenta inflexdes que
distinguem trés partes da mesma: a primeira e a ultima descrevem o comportamento das
maximas e minimas, respectivamente, enquanto o trecho médio representa a faixa
dominante de vazées (VIROES, 2013).

Em alguns estados, para avaliacdo dos pedidos de outorga, a vazao associada as
permanéncias de 90% (Qg) ou 95% (Qgs) sdo usadas como valores de referéncia para o
processo de outorga, sendo disponibilizado apenas um percentual destas vazdes de
referéncia (ANA, 2007a).

3.6 Redes hidrolégicas brasileiras

O levantamento das informagdes necessarias a Hidrologia é realizado por meio de
redes de estacgdes hidrométricas, cujas séries de dados tém sua importancia proporcional a
sua extensao temporal. O cadastro de estagdes hidrométricas no Brasil foi iniciado por volta
de 1968, capitaneado pelo entdo Departamento Nacional de Aguas e Energia Elétrica —
DNAEE (ANA, 2007b). Criada em 17 de julho de 2000 e instituida em 19 de dezembro do
mesmo ano, a Agéncia Nacional de Aguas — ANA recebeu, dentre outras, a atribuigdo de
promover a coordenacdo das atividades desenvolvidas no ambito da Rede
Hidrometeorolégica Nacional.

Segundo a ANA, existem cerca de 14.822 estagbes hidrometeorolégicas 63 em todo
o pais (ANA, 2007b). Com essas estagbes, é possivel mensurar o volume de chuvas,
evaporagao da agua, nivel e vazao dos rios, quantidade de sedimentos e qualidade das
aguas em estacdes, respectivamente, pluviométricas, evaporimétricas, fluviométricas,

sedimentométricas e de qualidade da agua.



Do numero total de estagbes cadastradas, 8.102 s&o pluviométricas e 5.283 séo
fluviométricas. As informacdes oriundas desse monitoramento encontram-se disponiveis no
Sistema de Informagdes Hidrologicas - HidroWeb e no Sistema Nacional de Informagoes
sobre Recursos Hidricos - SNIRH.

O estabelecimento de uma boa rede hidroldgica e sua manutencgao ininterrupta sao
pecas fundamentais na conducao de estudos hidrolégicos, pois a precisao das estimativas
das variaveis hidroldégicas depende da disponibilidade de dados primarios confiaveis
(OLIVEIRA, 2008). Entretanto uma rede hidrométrica dificiimente cobre todos os locais de
interesse, necessarios ao gerenciamento dos recursos hidricos de uma regido. A escassez
de dados, em especial os fluviométricos, € decorrente do elevado custo que envolve a
implantagao, operagéo e manutengdo de uma rede de monitoramento (ARAUJO, 2008).

Sob coordenagao da ANA, a Rede Hidrometeoroldgica monitora menos de 20% dos
rios, cerca de 2.176 dos 12.963 mil rios brasileiros cadastrados no Sistema de Informacoes
Hidroldgicas, inclusive os fronteirigcos e transfronteiricos (ANA, 2007b). Como a maioria dos
postos fluviométricos estdo localizados nas grandes bacias hidrograficas, a escassez de
séries historicas em pequenas bacias € uma realidade.

No caso das bacias sem monitoramento, adota-se a técnica da regionalizagéo, que
objetiva, dentre outros aspectos, transferir informagdes daquelas regibes onde sao

realizados monitoramentos para as areas ainda carentes de dados (VIROES, 2013).

3.7 Regionalizacao hidrolégica

A regionalizagdo hidrolégica apresenta-se como uma técnica por meio da qual é
possivel a transferéncia de informacdes dentro de uma area com comportamento hidrolégico
uniforme (REIS et al., 2013). Objetiva, principalmente, estimar o escoamento superficial
(vazao) da rede de drenagem de uma bacia hidrografica e é realizada a partir das séries
historicas de vazao (CASTRO; RUHOFF, 2009).

De acordo com Tucci (2009), os dados hidrolégicos passiveis de serem
regionalizados sao: variaveis, fungdes e parametros. Varidveis: a vazao média de longo
termo, a precipitacdo média anual e a evapotranspiracdo potencial e real; funcdes: curvas
de permanéncia e de regularizacao, distribuicdes de probabilidades empiricas e tedricas de
chuva, e descarga diarias maximas e minimas anuais; parametros: sejam eles de modelos
ou representantes de caracteristicas das bacias hidrograficas.

A importancia da regionalizagcado de vazdes nao se deve apenas ao fato de ela ser
capaz de espacializar as informagdes hidrolégicas, mas também por identificar aquelas

areas que necessitam de melhoria da rede hidrometeorolégica, seja pela instalacao de
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novas ou relocagao de estagdes existentes. Além disso, podem fornecer um diagndstico da
qualidade dos dados das estagbes, funcionando como ferramenta de auxilio a analise de
consisténcia dos dados (VIROES, 2013).

Diversos métodos tém sido testados e utilizados, em inumeros estudos hidrolégicos
realizados. Almeida (2010) relata que os métodos tém buscado agregar caracteristicas
hidrolégicas a analises estatisticas, procurando uma forma mais objetiva de obter equagdes

que possam ser aplicadas a uma determinada regio.

3.7.1 Meétodo tradicional

O método tradicional consiste na identificacdo de regido hidrologicamente
homogénea e no ajuste de equacgdes de regresséo regionais entre as diferentes variaveis a
serem regionalizadas (vazbes) e as caracteristicas fisicas e climaticas das bacias de
drenagem para cada regido homogénea (ELETROBRAS, 1985a), aplicavel as vazdes
minimas, maximas e médias, bem como as curvas de permanéncia. Dependendo da
variavel, algumas configuragbes complementares passam a ser requeridas. Para a vazéo
minima deverdo ser informados o tempo de retorno e a duragdo; para a vazao maxima o
tempo de retorno; para a curva de permanéncia a probabilidade de excedéncia da vazédo no
tempo (SOUZA, 20009).

Inicialmente, o procedimento deste método envolve a definicdo prévia das regides
hidrologicamente homogéneas e, em uma segunda etapa, a obtencdo de equacdes que
permitam associar a vazao com variaveis topoldgicas e climaticas da bacia de interesse
(PRUSKI et al., 2012).

Regides homogéneas podem ser definidas como aquelas que exibem
comportamento hidrolégico similar, que por sua vez é fungdo da reunido de fatores
climaticos e fisicos (WOLFF, 2013). Habitualmente ndo se estendem por grandes areas,
devido a variabilidade do clima, da topografia, da cobertura vegetal e do tipo de solo. No
entanto, a delimitacdo de areas excessivamente reduzidas resulta numa caréncia de dados
que prejudica a confiabilidade das estimativas (LEMOS, 2006).

A Eletrobras (1985a) apresentou dois critérios para delimitacdo das regides
homogéneas: primeiro considera que, as séries de vazdo sdo transformadas em séries de
vazado adimensionalizadas, dividindo os seus valores pelas correspondentes médias, e a
distribuicdo de frequéncia dessas séries adimensionalizadas devem ser proximos. O
segundo baseia-se na analise do ajuste de um modelo matematico de regressdo multipla
das vazdes minimas, maximas e médias, com as caracteristicas fisicas e climaticas servindo

como variaveis independentes.
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Quando os dois critérios apresentarem bons resultados, a regiao é definida como
hidrologicamente homogénea para as vazdes estudadas. Entretanto, nos casos em que isso
nao ocorreu, havera a necessidade de subdividir a regido ou reorganizar as estagcdes dentro
das regides e reiniciar o processo (ELETROBRAS, 1985a)

Definidas as regides homogéneas, o préximo passo € aplicar a regressao multipla
entre estas vazdes e as variaveis explicativas selecionadas, para o estudo, conforme a

funcao:

Q=fWVz ... V) (1)

em que:

- Q é avazao de interesse;

- f (W, Vs, ..., V) representa uma fungao (linear, exponencial, potencial, logaritmica ou
outra) das variaveis explicativas, sendo elas as caracteristicas fisicas ou climaticas da
regiao em estudo.

Torna-se necessario investigar a melhor combinacdo possivel de variaveis
independentes que representem a distribuigdo dos valores da variavel dependente
(CASTRO; RUHOFF, 2009). As variaveis explicativas empregadas nos modelos de
regressao sao caracteristicas fisicas e climaticas da bacia hidrografica (OLIVEIRA, 2008).

De acordo com Almeida (2010), a consideragéo de determinadas caracteristicas na
regionalizacdo dependera do seu grau de importancia na regido a ser estudada, bem como,
se a utilizagdo das mesmas implica ou ndo ha existéncia de modelos de regionalizagdo mais
condizentes com a realidade.

Em estudos de regionalizagdo de vaz&o, € importante conhecer as caracteristicas
fisicas e climaticas que influenciam e explicam o comportamento e a distribuicdo das vazoes
a serem regionalizadas, priorizando aquelas que sejam de facil determinacao (OLIVEIRA,
2013). Essas caracteristicas, fisicas e climaticas, devem ser determinadas para a area de
drenagem a montante de cada uma das estagbes fluviométricas existentes na bacia
(ARAUJO, 2008).

Geralmente as variaveis fisicas utilizadas na regionalizacdo s&o: area de drenagem,
comprimento do rio principal, declividade média do rio principal, densidade de drenagem e
desnivel médio da bacia (CASTRO; RUHOFF, 2009). Dentre as caracteristicas fisicas, a
precipitacao tem sido utilizada como variavel explicativa em diversos trabalhos de
regionalizacado de vazoes, pois € o fendmeno climatico que influencia diretamente o regime
de escoamento de um curso d’agua (OLIVEIRA, 2013). As precipitagdes mais utilizadas sao

a anual, as semestrais e as trimestrais (RODRIGUEZ, 2008).
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3.7.2 Método da interpolagao linear

Em 1985, a Eletrobras apresentou, no Manual de Minicentrais Hidrelétricas, uma
solugdo para quando nao se dispde de registros fluviométricos. O manual traz o
procedimento de translagdo dos dados. De acordo com Eletrobras (1985b), a translacao dos
dados s6 pode ser considerada valida se as areas de drenagem nos locais do posto e da
secao em que se quer determinar a vazao nao forem excessivamente diferentes.

Este método, parte do principio de que a vazao na secao de interesse pode ser
obtida por uma relagao de proporcionalidade entre as vazdes e as areas de drenagem dos
postos fluviométricos mais préoximos, sendo baseado na vazao especifica (NOVAES et al.,
2007). A interpolacdo linear ndao necessita da divisdo da area de estudo em regides
homogéneas, sendo a metodologia aplicavel em secbes de rio de uma mesma bacia

hidrografica que possua estagdes com série historica de vazao (ALMEIDA, 2010).

3.7.3 Meétodo da interpolagao linear modificado

Conforme ja descrito, o método baseado na Interpolagao linear considera que a
vazao na sec¢ao de interesse é uma proporcionalidade entre as areas de drenagem da sec¢ao
de interesse e os postos fluviométricos mais préximos. Considerando que o processo fisico
de formacao das vazdes é mais dependente dos volumes precipitados do que das areas de
drenagem, Novaes et al. (2007) propuseram a modificagdo do método de interpolacao
linear. Essa modificacao consiste em inserir a variavel precipitacdo média, considerando
assim que a vazao na secao de interesse é também proporcional a relagdo entre os volumes

precipitados. Esse método ficou conhecido como Interpolagéo linear modificado.

3.7.4 Meétodo de Chaves

A metodologia descrita por Chaves et al. (2002) tem a finalidade de propor um
método que seja condizente com a realidade da maioria das bacias hidrograficas. Lemos
(2006) afirma que, como geralmente ha escassez de informagdes ou bases de dados
reduzidas, a precisdo do meétodo tradicional é prejudicada, podendo até ndo se tornar
recomendavel, em razdo da dificuldade na identificacdo das regides homogéneas, bem
como na obtengao das equagdes de regressao regionais.

A proposicao de uma metodologia de regionalizagao de vazdes que necessite menos
informacdes que o método tradicional e que proporcione uma boa confiabilidade ¢ uma

grande contribuicdo para o gerenciamento dos recursos hidricos, colaborando, assim, para a
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otimizacdo do uso da agua e, consequentemente, para a minimizagao dos conflitos entre os
usuarios (NOVAES, 2005).

Devido ao advento dos Sistemas de Informacdes Geograficas (SIG’s), a
espacializagao de variaveis hidrolégicas tornou-se uma tarefa mais facil, explorando-se de
forma mais acentuada as informacdes existentes, seja a montante ou a jusante do local de
interesse (CHAVES et al.,, 2002). O objetivo desses autores foi propor uma metodologia
simples para a regionalizacdo de vazdes minimas em bacias hidrograficas com série de
dados limitada, utilizando técnicas de interpolagdo em um ambiente SIG.

A metodologia baseia-se na interpolagéao e extrapolagdo de vazdes minimas, a qual
apresenta solugdes que dependem da posi¢ao relativa da secao de interesse em relacéo
aos postos fluviométricos mais proximos. As variaveis utilizadas para a estimativa das
vazdes nas secoes de interesse sdo a area de drenagem e as distancias entre a secéo de
interesse e o posto fluviométrico considerado (FERREIRA, 2010).

Para validagdo do método, Chaves et al. (2002) comparam o resultado do método
proposto com os valores de vazdo minima obtidos na regionalizagdo com método
tradicional. O estudo foi realizado na bacia do ltapicuru, localizada na porcdo nordeste do
estado da Bahia, por ser uma bacia hidrografica com baixa densidade de postos
hidrométricos (tipica da situagao brasileira).

Ao final do estudo os autores, concluiram que a metodologia descrita por eles,
apresentou melhores resultados quando comparada ao método de equacdes de regressao,

uma vez que os erros relativos médios foram de 45% e 289%, respectivamente.

3.7.5 Método de Chaves modificado

Considerando o mesmo principio utilizado na remodelacdo do método da
Interpolacao linear modificado, ou seja, considerando o processo fisico de formagao das
vazoes serem mais dependentes dos volumes precipitados do que das areas de drenagem,
Novaes et al. (2007) alteraram o método proposto por Chaves et al. (2002), inserindo a

variavel precipitagdo média, intitulado como método de Chaves modificado.
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4 MATERIAL E METODOS

4.1 Descricao da area de estudo

A bacia hidrografica do rio Piquiri abrange uma area de drenagem de 24.156 km?2.
Localizada integralmente no estado do Parana, no quadrilatero formado pelas projecoes
universal transversas de Mercator de 7384962,29 e 7199801,53 norte e 439551,83 e
183689,15 oeste (Figura 1) (IAP, 2008).

[
. 200000 250000 300000 350000 400000 450000
Brasil f 1 1 1 1 1

b Bacias hidrograficas do rio Piquiri B
o o
O Nl
o o
o o
© ©
[ [
~ ~
o o
O el
o o
2 2
Bacias hidrograficas do Parana | & ,‘3
o i o
o O
o - o
S "N E =}
o o
1 \F S
~ s N~

T 1 1 1 T 1
200000 250000 300000 350000 400000 450000
SUDERHSA (2007)

Figura1 Localizacdo geografica da bacia hidrografica do Rio Piquiri - PR. Datum
WGS-84, coordenadas UTM, zona 22 S.

O rio Piquiri, principal curso de agua da bacia, tem suas nascentes no terceiro
planalto, regido centro-sul do Estado, préximas ao municipio de Campina do Simé&o e foz no
rio Parana. Ao longo do seu percurso recebe como principais contribuintes, de montante
para jusante, os rios do Cobre, Bandeira, Cascudo, Feio, Sao Francisco, Tourinho, Melissa,
Jesuitas, Verde, Encanto e Azul, pela margem esquerda. Pela margem direita, contribuem
os rios Cantu, Sapucai, Goio-Bang, Goio-eré, Jangada e Xambré (I1AP, 2008).

Os solos predominantes na bacia sdo Latossolo, Argissolo e Nitossolo vermelhos e,

a leste, ha porcbes mais significativas de Neossolos. Ao norte, as texturas variam pouco
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entre arenosa e média arenosa, prevalecendo texturas mais argilosas nas demais regioes
(PARANA, 2013).

A temperatura média no més mais frio é inferior a 18 °C; no més mais quente é
acima de 22 °C, verdes quentes, geadas pouco frequentes e tendéncia de concentracao das
chuvas nos meses de verdo, contudo sem estagéo seca definida (IAP, 2008).

A atividade econbmica principal é a agropecuaria e as culturas mais importantes sao:
a soja, o trigo, a cana de agucar e a mandioca; Ha também areas de pastagens. A bacia é
bem dividida entre as classes de uso misto, agricultura intensiva e pastagens artificiais e
campos naturais. Ha, ainda, pequenas areas de cobertura florestal e concentragbes urbanas

e industriais, com destaque para a regido de Cascavel (PARANA, 2013).

4.2 Selegao, analise e tratamento dos dados

Para a execugdao deste trabalho, utilizaram-se os dados de 18 estacbes
fluviométricas e 48 pluviométricas, que fazem parte da rede hidrometeoroldgica do Sistema

de Informagdes Hidrologicas (HIDROWEB), da Agéncia Nacional de Aguas.

4.2.1 Dados pluviométricos

Na Tabela 1 estdo apresentadas as 48 estacbes pluviométricas, com base nos
respectivos codigos, nomes, periodos de dados e coordenadas UTM. Na Figura 2 é possivel

visualizar a distribuicao espacial das estagdes sobre a bacia hidrografica do rio Piquiri.

Tabela1 Estacdes pluviométricas selecionadas

Periodo de o
Codigo Estacédo dados Localizagao (UTM)

Inicio Fim Latitude Longitude
2352026 Canaa 1976 2011 7354773 301057
2353003 Alténia 1967 2011 7359434 206381
2353004 Cruzeiro do oeste 1957 2011 7368863 287864
2353005 Xambré 1967 2011 7373032 246579
2353006 Mariluz 1967 2011 7345997 279604
2353016 Pérola 1976 2011 7365727 227416
2353047 Iguaipora 1976 2011 7348176 198092
2451010 Londrina 1967 2011 7242187 410856
2451021 Faxinal 1975 2011 7259209 403556
2452000 Balsa do Cantu 1967 2012 7261829 327937
2452001 Ponte do Goio-Bang 1967 2012 7276163 304326

Continua...
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Lo - Periodo de Localizagao (UTM)
Cédigo Estagao dados
Inicio Fim Latitude Longitude

2452009 Ubirata 1965 2011 7285322 299130
2452010 Janiopolis 1967 2011 7329922 320520
2452011 Campina da Lagoa 1966 2012 7278218 317379
2452012 Altamira do Parana 1966 2011 7256170 328203
2452014 Mamboré 1965 2011 7313638 346108
2452015 Roncador 1965 2011 7278795 371806
2452016 Palmital 1965 2011 7247353 378552
2452019 Laranjal 1975 2011 7246930 351165
2452029 Farol 1975 2011 7334837 335231
2452033 Primavera 1975 2011 7307577 303914
2452035 Guarani 1974 2011 7296989 342910
2452040 Pensamento 1975 2011 7309762 332618
2452041 Santo Antbnio 1975 2011 7289828 374042
2453000 Balsa Santa Maria 1972 2012 7324649 222322
2453001 Ponte do Piquiri 1970 2012 7286888 280523
2453008 Alto Piquiri 1967 2011 7342035 251874
2453009 Porto Formosa 1966 2012 7321694 263042
2453010 Formosa do Oeste 1967 2011 7312521 264887
2453012 Corbélia 1965 2011 7255282 267536
2453013 Salto Sapucai 1964 2012 7274070 287477
2453014 Ponte tourinho - Braganey 1966 2011 7246458 291269
2453016 Goio-eré 1967 2011 7322911 293653
2453030 Bragantina 1975 2011 7275639 235363
2453037 Palmitopolis 1975 2011 7280285 259009
2453043 Novo Porto 2 1978 2012 7299839 282011
2453047 Vila Maripa 1976 2011 7296779 214410
2453048 Alto Santa Fé 1976 2011 7299276 202599
2453050 Brasilandia do Sul 1976 2011 7321539 243505
2453052 Rio Bonito 1976 2011 7333467 200099
2453056 Sao Jodo do Oeste 1975 2011 7237343 273507
2454006 Terra Roxa do Oeste 1967 2011 7323872 185043
2551009 Campina do Simao 1967 2011 7222763 418741
2552006 Guaraniagu 1965 2011 7224544 310103
2552008 Marquinhos 1967 2011 7222077 373174
2552019 Campo verde (faxinal dos indios) 1975 2011 7209690 355882
2552047 Vila Guarani 1976 2011 7210665 333645
2553019 Ibema 1976 2011 7222427 291636

Os dados analisados séo de 31 anos (de 1980 a 2010). Nesse periodo, foram

identificadas as falhas nas séries, com auxilio de um diagrama de barras (Apéndice A -

Figura 19), as quais foram preenchidas por meio do método de ponderagdo regional,

baseado nas correlagbes com as estacdes vizinhas. Foram estabelecidos os coeficientes de

correlacao entre o posto pluviométrico com falha (Y) e trés postos vizinhos (X1, X2, X3).

Para o posto Y, o preenchimento da falha foi realizado pela Equacao 2.

_ Tyx1Px1 + 1vx2Px2 + 1yx3Px3

y =

Tyx1 T Tyxz2 + Tvx3

(2)
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em que:

- Py é a precipitacéo a ser estimada (mensal) para o posto Y;

- Tyx1,Tyx2 Tyxs, representam, respectivamente, os coeficientes de correlagédo das
precipitacoes entre Y e X1, Y e X5, e Y e Xj;

- Py4, Py, Px3, representam as precipitagcdes dos postos X4, X; € Xs.
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Figura2 Localizacdo das estagdes pluviométricas selecionadas para o estudo. Datum
WGS-84, coordenadas UTM, zona 22 S.

Para a aplicacdo do método foi adotado como critério minimo a obtencdo de um
coeficiente de determinacédo superior a 0,7, segundo recomendacdes de Barbosa et al.
(2005) e Pruski et al. (2004) e a proximidade das estacoes.

Em seguida, foi realizada a analise da consisténcia de cada estacao, dentro de uma
visdo regional, com o0 objetivo de comprovar o grau de homogeneidade dos dados
disponiveis num posto, com relagdo as observacdes registradas em postos vizinhos. Para
tanto, foi utilizado o método da dupla massa.

O método consiste em comparar os valores acumulados anuais (ou sazonais) da
estacao X com os valores da estacao de referéncia, que €, usualmente, a média de diversos
postos vizinhos (FREIRE; OMENA, 2005).
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4.2.2 Dados fluviométricos

Na Tabela 2 sao apresentadas as 18 estagdes fluviométricas, com base nos
respectivos codigos, nomes, periodos de dados e coordenadas UTM. Na Figura 3 é possivel

visualizar a distribuicao espacial das estagdes sobre a bacia hidrografica do rio Piquiri.

Tabela 2 Estacdes fluviométricas selecionadas

o Periodo de
ID Cédigo Nome Rio Localizagao (UTM) dados
Latitude Longitude Inicio Fim

1 64764000 Guampara Rio Piquiri 7236358 370545 1984 2002
2 64765000 Porto Paiqueré Rio Piquiri 7230558 345372 1971 1983
3 64767000 Porto Carriel Rio Piquiri 7240053 338869 1981 2010
4 64771500 Porto Guarani Rio Piquiri 7248767 321951 1976 2005
5 64773000 Ponte Ledncio Primo Rio Cantu 7258554 375392 1978 2003
6 64775000 Balsa do Cantu Rio Cantu 7261859 327852 1967 2005
7 64776100 Foz do Cantu Rio Piquiri 7261259 310268 1986 2005
8 64780000 Ponte Tourinho Rio Tourinho 7244873 290199 1966 1979
9 64785000 Ponte do Goio-Bang Rio Goio-Bang 7276164 304354 1967 2005
10 64790000 Salto Sapucai Rio Sapucai 7274101 287476 1966 2005
11 64795000 Ponte do Piquiri Rio Piquiri 7286889 280523 1970 2003
12 64799500 Novo Porto 2 Rio Piquiri 7299365 281258 1978 2003
13 64800000 Porto 2 Rio Piquiri 7307202 278542 1962 1978
14 64810000 Balsa do Goio-eré Rio Goio-eré 7353403 282914 1963 2004
15 64815000 Fazenda Uberana Rio Goio-eré 7329138 264612 1978 2005
16 64820000 Porto Formosa Rio Piquiri 7321694 263070 1966 2004
17 64830000 Balsa Santa Maria Rio Piquiri 7324706 222066 1969 2003
18 64833000 Ipora Rio Xambré 7346254 220203 1994 2001

E importante ressaltar a dificuldade que se tem para encontrar, numa mesma regido,
séries historicas de vazéo e chuvas, sem falhas ou em um mesmo periodo de registro. O
ideal, nas analises histéricas, é utilizar dados com o mesmo periodo base, mas isto nem
sempre é possivel. Por esta razao, foram utilizados dados de vazao disponiveis nos postos
de monitoramento.

Foram computados os registros de periodos continuos e dados faltantes, expressos
no diagrama de barras (Figura 20 - Apéndice A). Para os postos utilizados, foram eliminados
0s meses que apresentarem mais de 5% de registros sem informacéo e as demais falhas

nao foram preenchidas.
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Figura3 Localizagdo das estagbes fluviométricas selecionadas para o estudo. Datum
WGS-84, coordenadas UTM, zona 22 S.

4.3 Obtencao das variaveis dependentes

As variaveis dependentes utilizadas para a regionalizagdo de vazbes na bacia
hidrografica do rio Piquiri foram: a vazao minima (Q1), vazdo média de longa duracéo
(Qmed), vazdo maxima (Qmaxt) € vazdes de permanéncia de 90% e 95% (Qgo € Qugs).

Para tanto, utilizou-se o Sistema Computacional para Analise Hidrologica (SisCAH
1.0), que é um software desenvolvido pela rede de pesquisa 2 do SNIRH, supervisionada
pela ANA e que é composta pelas seguintes instituicdes: Universidade Federal de Vigosa
(instituicao coordenadora), Universidade Federal da Bahia, Universidade Federal
Fluminense, Universidade Federal de Pernambuco, Universidade Federal do Espirito Santo,
Escola de Engenharia de Sdo Carlos e Instituto de Pesquisas Tecnologicas.

As vaz6es maximas foram regionalizadas associadas a um periodo de retorno de 2,
5, 10, 25, 50 e 100 anos e as vazdes minimas com duracao de sete dias foram associadas

ao periodo de retorno de 10 anos.
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As séries anuais de vazdes maximas diarias e minimas com sete dias de duragéo,
para cada estacdo, foram submetidas a analise estatistica para identificagdo do modelo
probabilistico que melhor se ajustasse aos dados.

Para representar as séries de vazdes maximas e minimas foram testadas as
distribuicdes de probabilidade disponiveis no SisCAH: Pearson tipo Ill, Log-Normal a dois e
trés parametros e Log-Pearson tipo Ill, Gumbel (apenas para maximas) e Weibull (apenas
para minimas).

O critério para a escolha da distribuicdo de probabilidade das vazoées, utilizado pelo
SisCAH 1.0, é o menor erro padrao e, consequentemente, o menor intervalo de confiancga.

Conforme Chow, Maidment e Mays (1988), o erro padrdo da estimativa € uma
medida do desvio padréao das grandezas dos eventos calculados a partir de amostras sobre
a verdadeira grandeza evento. Os autores também descrevem que o intervalo de confianga
depende do nivel de confiangca. No SisCAH 1.0 é utilizado o nivel de confiangca de 95% e,

segundo Kite (1988), a estimativa dos limites do intervalo é calculada utilizando-se a

Equacéo 3.
M—-1968<IC<M+19668 (3)
em que:
M = magnitude do evento;
1) = erro padrao pertinente a cada funcao de probabilidade;
IC = intervalo de confianga, ao nivel de confianca de 95%.

Esse intervalo foi analisado para todas as estagbes fluviométricas e aquela
distribuicdo que apresentou mais vezes o menor intervalo de confianca foi adotada para a
estimativa dessas vazoes.

A vazao média de longa duracgao, por ser caracterizada como a média das vazdes
médias diarias, foi regionalizada sem se considerar um periodo de retorno.

O procedimento para a obtengdo da curva de permanéncia para cada estagao
fluviométrica foi baseado na obtencédo de classes de frequéncia e que segue 0s passos
definidos a seguir.

Definicdo de 50 intervalos de classe das vazbes diarias, sendo a subdivisdo das
classes feita com base na escala logaritmica, devido a grande variagdo de magnitude das

vazdes envolvidas. O calculo do intervalo de classe (AX) é feito conforme Equacao 4:

— ”n(Qméx) - ln(Qmin)]

=0 (4)

AX

em que:
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- Qnax € @ vazdo maxima;

- Qmin € @ vazdo minima da série.

Definicdo dos limites dos intervalos de classe, pela Equacdo 5, a partir de Qin,
adicionando-se o intervalo calculado anteriormente, o que resulta na vazao do limite superior

do intervalo i.

Qi+1 = exp[In(Q;) + AX] ()

Determinacdo, com base nos dados de vazdo da série historica de cada estacéo
fluviométrica, do numero de vazobes classificadas em cada intervalo. Calculo da frequéncia

(fi) associada a cada intervalo, conforme Equacgao 6.
— Nai
fi = 57 100 (6)

em que :
- Ng; € o numero de vazdes de cada intervalo;
- NT é o numero total de vazdes.
Para obtencdo da curva de permanéncia plotando-se na ordenada os limites

inferiores dos intervalos de classe de vazao e na abscissa a frequéncia de ocorréncia.

4.4 Obtencao das variaveis independentes

4.4.1 Caracteristicas fisicas

Para os procedimentos que foram realizados com o intuito de se obterem as
caracteristicas fisicas da area de estudo, utilizou-se o software ArcGis 10.1, desenvolvido
pelo Environmental Systems Research Institute — ESRI, que permite gerenciar bancos de
dados georreferenciados e realizar analises espaciais e bases cartograficas digitais no
formato vetorial Shapefile (.shp) e matricial raster ((GRID/.TIN).

O Modelo Digital de Elevag¢ao (MDE) do estado do Parana, utilizado neste estudo, foi
o disponibilizado por Valeriano (2004), o qual foi gerado a partir do projeto Shuttle Radar
Topographic Mission (SRTM) que advém de cooperagao entre a National Aeronautics and
Space Administration (NASA) e a National Imagery and Mapping Agency (NIMA), do

Departamento de Defesa (DOD) dos Estados Unidos e das agéncias espaciais da Alemanha
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e da ltalia (VALERIANO; ABDON, 2007), em escala 1:250.000 e em resolucao espacial de
30 metros.

A delimitagcao da bacia hidrogréfica, utilizada neste estudo em formato Shapefile, foi
a disponibilizada pela SUDERHSA (2007) no site do Instituto de Aguas do Parana e
elaborada com base nas cartas do DSG/IBGE nas escalas 1:50.000 e 1:100.000.

As caracteristicas fisicas escolhidas para a construcdo dos modelos de
regionalizagao foram: area de drenagem (A), comprimento do rio principal (Lp), declividade
entre a nascente e a foz do rio principal (Sl), declividade média da bacia (Sm) e densidade

de drenagem (Dd). Na Tabela 3 é apresentado o resumo da metodologia que foi utilizada

para extracao das caracteristicas fisicas das sub-bacias.

Tabela 3 Resumo da metodologia para extragao das caracteristicas fisicas

Caracteristica
fisica

Ferramenta utilizada no ArcGis

Forma de obtencao

Area de drenagem (A)

Delimitacédo: Hydrology > Watershed.

Conversao da imagem: Spatial Analyst >
Convert Raster to Features.

A partir da localizacao das
estagoes fluviométricas.

Comprimento do rio
principal (Lp)

Isolamento: Map Algebra > Raster
Calculator

Conversdo da imagem: Conversion Tools
> From Raster > Raster to Polyline

Valor direito na tabela de atributos

A partir do mapa de direcéo de
fluxo e de fluxo acumulado.

Declividade do rio
principal (SlI)

Definicao dos pontos: Data management
tools > Features > Feature Vertices To
Points

Obtencéao das cotas : 3D Analyst Tools >
Functional Surface > Interpolate Shape

Razao entre a diferenga das
cotas dos pontos iniciais e
finais do rio pelo comprimento
total do mesmo.

Declividade média da
bacia (Sm)

Declividade da bacia: Surface Analysis
Tools > Surface > Slope

Declividade média das sub-bacias:
Surface Analysis Tools > Zonal > Zonal
Statistics as Table

Média das declividades de
todas as células de cada sub-
bacia (area de drenagem).

Densidade de
Drenagem (Dd)

Isolamento: Map Algebra > Raster
Calculator

Conversao da imagem: Conversion Tools
> From Raster > Raster to Polyline

Comprimento total dos rios — Soma dos
valores na tabela de atributos.

Razao entre os comprimentos
totais dos cursos d’ agua

(X L) de cada sub-bacia por
sua respectiva area (A).

Dd = Y Leot
A

Fonte: adaptado de ALMEIDA (2010).

4.4.2 Caracteristicas climaticas

As caracteristicas climaticas utilizadas foram: a precipitacdo total anual (Ptot), a
precipitacado do trimestre mais seco (Ptris) e a precipitagdo do trimestre mais chuvoso (Ptric).

Essas variaveis foram obtidas para cada estacao pluviométrica e, a partir da localizagao de



22

cada uma delas, sdo produzidos os mapas de isoietas, visando a determinacdo das
precipitacbes médias nas areas de drenagem das sub-bacias consideradas. As isoietas
foram tragadas utilizando-se 0 método de interpolagdo pelo quadrado médio da distancia
(IDW).

4.5 Métodos de regionalizagcao

Foram utilizados cinco métodos para a regionalizacdo de vazdées na bacia
hidrografica do rio Piquiri:

e Meétodo tradicional, descrito por Eletrobras (1985a);

e Meétodo da interpolagéo linear, descrito por Eletrobras (1985b);

e Método da interpolacéo linear, modificado por Novaes et al. (2007) ;

e Meétodo proposto por Chaves et al. (2002);e

¢ Método de Chaves modificado por Novaes et al. (2007).

4.5.1 Método tradicional

Segundo o procedimento descrito por Eletrobras (1985a), inicialmente, buscou-se
determinar, para todas as estac¢des da regido de estudo, a melhor equacédo de regressao
das vazbes estudadas, considerando-se as caracteristicas fisicas e climaticas da bacia
escolhida.

Foram aplicadas regressdes multiplas entre as varidveis dependentes e
independentes. No presente estudo, foram analisados os modelos: linear, multiplo,

potencial, exponencial e logaritmico, expressos pelas Equacdes 7 a 11, respectivamente.

e Modelo linear
Q= Bo+p1V1 (7)

e Modelo multiplo
Q= Bo+p1Vi+ B Vo + -+ By (8)

e Modelo potencial

Q= ﬁovf1 ---Vnﬁn (9)
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e Modelo exponencial
Q= e,Bo‘l',31V1+"'+ﬁnVn (10)

e Modelo logaritmico
Q = Bo + BiLnVy + -+ BpLnVy, (11)

em que:

- Q é vazao que se deseja determinar;

- 11, V;, séo as variaveis explicativas (caracteristicas fisicas e/ou climaticas);

- Bo, B1, Bn. S@0 0s coeficientes de ajuste.

Os modelos de regressdo multipla foram selecionados com base nos critérios de
simplicidade do modelo e qualidade do ajuste.

A qualidade dos modelos gerados foi avaliada por meio do coeficiente de
determinacgao (R?), residuos, significancia do modelo pelo teste F, teste de hipoteses para os
parametros do modelo e analise dos residuos. O teste F e o teste de hip6teses para os
parametros foram realizados ao nivel de 5% de significancia.

Foram comparados com os demais métodos os modelos que apresentaram
concomitantemente: a) menor residuo; b) resultados significativos pelo teste F para o
modelo; c) resultados significativos pelo teste t para os parametros ajustados; d) coeficiente

de determinagao ajustado maior que 0,7.

4.5.2 Método baseado na interpolagao linear

Baseado no principio de que a vazao na secao de interesse é obtida pela relagao de
proporcionalidade entre as vazdes e as areas de drenagem dos postos fluviométricos mais
proximos (ELETROBRAS, 1985b), aplicou-se método da interpolacdo linear, no qual foi
necessario proceder ao enquadramento, dependendo da posicao relativa do ponto de
interesse em relacdo aos postos fluviométricos mais préximos, conforme os quatros casos

descritos a seguir.

e Casos 1 e 2 - Ponto de interesse localizado a montante e a jusante de um ponto

com vazao conhecida

Quando o ponto de interesse esta localizado a montante (Caso 1) ou a jusante

(Caso 2), conforme a Figura 4, a vazao desejada foi estimada pela Equagéao 12.
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Legenda

Area de drenagem na seg@o de interesse

D Area de drenagem do ponto de vazao conhecida

® Ponto com vazédo conhecida

@ Ponto de interesse

Figura4 Situagdo de um ponto de interesse, situado em trecho de canal a montante (a) e
a jusante (b) de um posto com vazao de referéncia conhecida.

Q. = (%2) Qm, (12)

em que:
Qz  =vazado na secdo de interesse, m>.s™;
Qm,j =vazao no posto de montante ou de jusante, m®.s™:
Az = area de drenagem na secéo de interesse, km?;

Am,j = area de drenagem do posto de montante ou de jusante, km?.
e Caso 3 - Ponto de interesse localizado entre dois pontos com vazao conhecida

Quando o ponto de interesse esta situado num trecho de canal entre dois postos
fluviométricos de vazdo conhecida, conforme a Figura 5, a vazao de referéncia incognita &

estimada por meio da Equagéao 13.

Legenda
. Ponto com vazéao conhecida
. Ponto de interesse
Area de drenagem na segéo de interesse

E Area de drenagem do ponto de vazao conhecida

Figura5 Situacdo de um ponto de interesse, situado entre dois postos com vazao de
referéncia conhecida.
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Q= Qm+ (i,:—j:) (Qj — @m) (13)

em que:

Qz = vazdo na secdo de interesse, m*.s™;

Qm = vazao no posto de montante, m*.s™;

Qj = vaz&o no posto de jusante, m*.s™;

Az = area de drenagem na secéo de interesse, km?;

Am = area de drenagem do posto de montante, km?

Aj = area de drenagem do posto de jusante, km?.

e Caso 4 - Ponto de interesse situado em um canal afluente cuja foz esta entre dois

postos fluviométricos de um canal de ordem superior

Este ponto é definido quando a sec¢ao de interesse esta situada em um trecho de um
rio afluente cuja foz localiza-se entre dois postos fluviométricos, situados em um rio de
ordem superior, conforme Figura 6. Neste caso, aplica-se uma combinac¢ao das outras duas
situacdes descritas anteriormente, sendo primeiramente calculada a vazao na segao de
confluéncia, utilizando-se a Equagéo 13. Em seguida, estima-se a vazdo na segédo de
interesse utilizando as vazdes nas confluéncias dos rios, aplicando-se a Equacdo 12 e

estimando-se a vazao na sec¢édo de interesse.

Legenda

@ Ponto de interesse
. Ponto com vazéo conhecida
@ Fozdo canal afluente
Area de drenagem na segéo de interesse
D Area de drenagem do ponto de vazao conhecida
:] Area de drenagem da foz do canal afluente

Figura 6 Situacdo de um ponto de interesse localizado em um canal efluente, cuja foz se
encontra entre dois postos de vazado conhecida, em um canal de ordem superior.

4.5.3 Método da interpolacao linear modificado

O método da interpolacédo linear modificado originou-se de uma adaptagdo do
método de interpolacao linear, a partir da adicdo da variavel precipitacao na execucédo dos

calculos, ou seja, considera que a vazao na secgado de interesse possui relacdo direta e
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proporcional a quantidade de chuva na respectiva area de contribuicdo (NOVAES et al.,
2007).
Desta forma, as Equacgdes 12 e 13 utilizadas no método baseado na interpolagao

linear passam a ser expressas pelas Equagbes 14 e 15, respectivamente.

A, P,
, = (2 oy (14)
Z " Z
_ AP, — Ay Py
Qz - Qm + (Ajpj —Aum (Q] Qm) (15)
em que:
Qz = vazdo na secdo de interesse, m*.s™;

Qm,j = vazao no posto de montante ou de jusante, m*.s™;

Qm = vazao no posto de montante, m*.s™;
Qj = vaz&o no posto de jusante, m*.s™;
Az = area de drenagem na secéo de interesse, km?;

Am,j = area de drenagem do posto de montante ou de jusante, km?;

Am = area de drenagem do posto de montante, km?;
Aj = 4rea de drenagem do posto de jusante, km?;
Pz = precipitacdo média anual na area de drenagem da secao de interesse, mm;

Pm,j = precipitacdo média anual na area de drenagem do posto de montante ou de

jusante, mm;
Pm = precipitacdo média anual na area de drenagem do posto de montante, mm;
Pj = precipitacdo média anual na area de drenagem do posto de jusante, mm.

Para a situacdo em que a secgao de interesse esta situada em um trecho de rio
afluente cuja foz esta entre dois postos fluviométricos situados em um rio de ordem superior,
aplicou-se o mesmo procedimento do método original, porém usando as novas equagdes

propostas neste método (Equagdes 14 e 15).

4.5.4 Método proposto por Chaves et al. (2002)

O método proposto por Chaves et al. (2002), também, apresenta quatro situacdes
distintas, dependendo da localizacdo da secao de interesse em relagao as se¢des de vazao
conhecida, entretanto, além das areas de drenagem, considera as distancias entre as

secOes analisadas.
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e Caso 1 e 2 -Ponto de interesse localizado a montante e a jusante de um ponto com

vazao conhecida

Quando a secao de interesse esta situada a montante (caso 1) ou a jusante (caso 2)
de um posto fluviométrico (Figura 4), a metodologia € idéntica a interpolagéo linear, sendo,

portanto, a vazao na sec¢ao de interesse calculada pela Equacéao 12.
e Caso 3 - Ponto de interesse localizado entre dois pontos com vazao conhecida
Ja no caso do ponto de interesse, situado em um trecho de canal entre dois postos

fluviométricos de vazéo de referéncia conhecida (Figura 5), a vazéo de incognita é estimada

pela Equacao 16.

Sendo:
d;
Pm = @t d) (17)
d
pj = W (18)
em que:

Qz = vazdo na secdo de interesse, m*.s™;
Qm = vazdo no posto de montante, m*.s™;
Qj = vaz&o no posto de jusante, m*.s™;
Az = 4rea de drenagem na secdo de interesse, km?;
Am = area de drenagem do posto de montante, km?;
Aj = 4rea de drenagem do posto de jusante, km?;
pm = peso relativo a estacdo de montante, adimensional; e
pj = peso relativo a estagcao de jusante, adimensional.

am = distancia entre o posto de montante e a se¢ao de interesse, km;

dj = distancia entre o posto de jusante e a secao de interesse, km.

e Caso 4 - Ponto de interesse situado em um canal afluente cuja foz esta entre dois

postos fluviométricos de um canal de ordem superior



28

Assim como apresentado no método da interpolacdo linear, a quarta situacéo
(caso 4) ocorre quando a sec¢ao de interesse esta situada em um trecho de rio afluente cuja
foz esta entre dois postos fluviométricos situados em um rio de ordem superior (Figura 6).
Neste caso, aplicou-se uma combinagao das outras duas situagdes descritas anteriormente,
sendo primeiramente calculada a vazao na secao de confluéncia dos rios (Equagao 16), em

seguida, utilizando a Equacéao 12, estimou-se a vazao na sec¢ao de interesse.

4.5.5 Método de Chaves modificado

Baseado no Método de Chaves et al. (2002), assim como no método da interpolagao
linear modificado, esta modificagdo se refere a inser¢cdo da variavel precipitacdo nos
célculos, pois também considera que a vazdo é influenciada pela precipitacdo e néo
somente pela area de drenagem (NOVAES et al., 2007).

Desta forma, as Equagbes 12 e 16 utilizadas no método de Chaves et al. (2002)

passam a ser expressas pelas Equagdes 14 e 19, respectivamente.

Q. = (4,R) K% n Z’J—%’)] (19)
em que:
Qz = vazdo na secdo de interesse, m*.s™;
Qm = vazdo no posto de montante, m*.s™;
Qj = vaz&o no posto de jusante, m*.s™;
Az = 4rea de drenagem na secdo de interesse, km?;
Am = area de drenagem do posto de montante, km?;
Aj = 4rea de drenagem do posto de jusante, km?;
Pz = precipitagcdo média anual na area de drenagem da secao de interesse, mm;
Pm = precipitacdo média anual na area de drenagem do posto de montante, mm;
Pj = precipitacdo média anual na area de drenagem do posto de jusante, mm;
pm = peso relativo a estacdo de montante, adimensional;
pj = peso relativo a estacao de jusante, adimensional.

4.6 Enquadramento dos postos fluviométricos existentes nos diferentes casos

Para aplicagdo do método de interpolacao linear, Chaves et al. (2002), método da

interpolagdo modificado e Chaves modificado, primeiramente observando o mapa da bacia
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com as estacdes fluviométricas plotadas, foi identificada cada situagao possivel, em relacao
aos postos fluviométricos existentes (Figura 7).

Visualiza-se na Figura 7 a estagdo Ipora (64833000), que se localiza em um rio
afluente cuja a foz encontra-se a jusante de uma estagado fluviométrica, situagdo nao
descrita pelas metodologias aplicadas. Chaves et al. (2002) descrevem que € possivel que
outras bacias, distintas daquela a que se aplicou primeiramente o método (Bacia do
Itapicuru), requeiram equagdes distintas, em fungdo de suas particularidades (rede de
drenagem, distribuicdo de postos etc.). No caso da estacao Ipora, aqui denominado de Caso
5, utilizou-se uma combinagdo dos casos ja descritos. Para a aplicagdo dos métodos
interpolagdo linear, interpolacdo linear modificado, Chaves e Chaves modificado.
Primeiramente, calculou-se a vazao na foz do rio Piquiri, utilizando-se a equagao do caso 2
e, em seguida, utilizando as equacdes do caso 4, calculou-se a vazao para a estagao Ipora
(64833000).

Partindo-se da nascente para a foz, determinou-se as Qumax 1, Q7.10, Qoo, Qos € Qmed,
para todos os postos fluviométricos de vazado conhecida, cujas vazdes foram supostas como
desconhecidas apenas para efeito de teste, em posterior comparacéo entre os valores das
vazdes estimadas com as demais metodologias e os valores observados.

Desta maneira, na Tabela 4 encontra-se o enquadramento das situa¢des dos postos
fluviométricos existentes na bacia hidrografica do rio Piquiri, em relacao ao (aos) posto (os)

fluviométrico (s) mais proximo (s).
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Figura7 Enquadramento das situagbes dos postos fluviométricos existentes em relacao
ao posto fluviométrico mais préximo. Datum WGS-84, coordenadas UTM,
zona 22 S.
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Tabela 4 Enquadramento das situagdes dos postos fluviométricos existentes em relacéo
ao posto fluviométrico mais préximo

Casos Caodigo Estagéao Rio
Caso 1 64764000 Guampara Rio Piquiri
Caso 3 64765000 Porto Paiqueré Rio Piquiri
Caso 3 64767000 Porto Carriel Rio Piquiri
Caso 3 64771500 Porto Guarani Rio Piquiri
Caso 1 64773000 Ponte Lebncio Primo Rio Cantu
Caso 4 64775000 Balsa do Cantu Rio Cantu
Caso 3 64776100 Foz do Cantu Rio Piquiri
Caso 4 64780000 Ponte Tourinho Rio Tourinho
Caso 4 64785000 Ponte do Goio-Bang Rio Goio-Bang
Caso 4 64790000 Salto Sapucai Rio Sapucai
Caso 3 64795000 Ponte do Piquiri Rio Piquiri
Caso 3 64799500 Novo Porto 2 Rio Piquiri
Caso 3 64800000 Porto 2 Rio Piquiri
Caso 1 64810000 Balsa do Goio-eré Rio Goio-eré
Caso 4 64815000 Fazenda Uberana Rio Goio-eré
Caso 3 64820000 Porto Formosa Rio Piquiri
Caso 2 64830000 Balsa Santa Maria Rio Piquiri
Caso 5 64833000 Ipora Rio Xambre

4.7 Comparacao dos resultados obtidos pelas diferentes metodologias

Uma vez obtidos os valores das vazdes estudadas (Q710, Qmaxtr» Qmed, Qoo € Qos),

utilizando-se as cinco metodologias (método tradicional, interpolacao linear, interpolagcao

linear modificado, Chaves e Chaves modificado), procedeu-se a avaliagdo dos métodos.

Como indicadores estatisticos foram utilizados os seguintes indices: a) erro relativo

(ER) entre o valor obtido a partir da analise da série historica e 0 estimado pelos métodos de
regionalizacao (Equacdo 20); b) erro médio (EM) (Equacao 21); c) indice de eficiéncia
proposto por Nash e Sutcliffe (N-S) (NASH; SUTCLIFFE, 1970) (Equacgéao 22); d) raiz do erro
médio quadratico (RMSE) (Equacado 23) e) coeficiente de concordancia modificado de
Willmott et al. (2012) (dr) (Equacéo 24).

Qobs - Qest

ER =100 X
Qobs

(20)

1 n
EM = E * ;(Qobs — Qest) (21)
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Z(Qobs - Qest)2

N—-S=1- — 22
Z(Qobs - Qobs)2 ( )
1 n
RMSE = ; * E(Qobs - Qest)z (23)
i=1
dr = 1— ZlnzllQobs - Qestl (24)

2 Z?:llQobs - Qobsl

em que:
- Qops € vazao obtida a partir da analise da série histérica (m? s‘1);
- Qet & vazdo estimada com base nas metodologias de regionalizagdo (m®s™);
- n é o numero de estagdes fluviométricas;

- Q,ps & a média das vazdes observadas (m®s™).
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5 RESULTADOS E DISCUSSAO

5.1 Variaveis dependentes

As distribui¢cdes de probabilidade mais adequada, ou seja, as que obtiveram o menor
intervalo de confianga, para cada estacdo fluviométrica, associadas a cada periodo de
retorno estudado, para as vazbes extremas (minimas e maximas), sao apresentadas na
Tabela 5. Os intervalos de confianga superior e inferior (95%), o erro padrao, os parametros
para os calculos das distribuicdes de probabilidades, de cada estacéo fluviométrica para
cada periodo de retorno, encontram-se no Apéndice B - Tabelas 21 a 37.

Segundo Naguettini e Pinto (2007), o intervalo de confianga varia em fungdo do
periodo de retorno, ou seja, a escolha da melhor distribuicado de probabilidade pode variar,
de acordo com o periodo de retorno adotado. Por essa razao, verificam-se na Tabela 5

diferentes distribuicdes de probabilidade em uma mesma estagao.

Tabela 5 Distribuicées de probabilidade que obtiveram o menor erro padrao, aplicadas em
cada estacdo e a cada periodo de retorno, para determinacao das vazbes
minimas associadas ao periodo de retorno de 10 anos (Q 10) € maximas (Quax.2,
Qméx,5, Qméx,wa Qméx,25, Qma’x,50e Qma'><,100)

Distribuicao

Codigo Estacao

Qmax,2 Qmax,5 Qmax,10 Qmax,25 Qmax,50 Qmax,100 Q7,10
64764000 Guampara G Log-N3 Log-N3 Log-N3 Log-N3 Log-N2 Pl
64765000 Porto Paiqueré Log-P 1l Log-N2 Log-N2 Log-N2 PII P P
64767000 Porto Carriel Log-P llI Log-P Il Log-Plll G G G Pl
64771500 Porto Guarani Log-P Il P Pl Pl P P P
64773000 Ponte Lebéncio Primo Log-P I Log-N3 Log-N3 Log-N3 Log-N3 Log-N2 Pl
64775000 Balsa do Cantu Log-N 2 Log-N3 Log-N3 Log-N3 Log-N3 Log-N3 Pl
64776100 Foz do Cantu Log-N 2 Pl Log-N3 Log-N3 Log-N3 Pl Pl
64780000 Ponte Tourinho Log-P llI Log-N3 Log-N3 Log-N3 Log-N3 Log-N3 Pl
64785000 Ponte do Goio-Bang Log-P Il P Pl Pl P P P
64790000 Salto Sapucai Log-N 2 Log-N3 Log-N3 Log-N3 G G P
64795000 Ponte do Piquiri G Log-N3 Log-N3 Log-N3 Log-N3 Log-N3 Pl
64799500 Novo Porto 2 Log-P IlI Log-N3 Log-N3 Log-N3 Log-N3 Log-N3 P 1
64800000 Porto 2 Log-P IlI Log-N3 Log-N3 Log-N3 Log-N3 Log-N3 P 1
64810000 Bolsa do Goio-eré G Log-N3 Log-N3 Log-N3 Log-N2 Log-N2 P 1
64815000 Fazenda Uberana Log-P IlI Log-P Il Log-P Ill  Log-P Il Log-P Il  Log-P Il P 1
64820000 Porto Formosa Log-P IlI Log-P Il Log-N3 Log-N3 Log-N3 Log-N3 P 1
64830000 Balsa Santa Maria G Log-P Il Log-P Il Log-P Il Log-N2 Log-N2 P
64833000 Ipora Log-P IlI Log-N3 Log-N3 Log-N3 Log-N2 Log-N2 P

Notas: * P lll: Pearson tipo Ill, Log-N 2: Log-Normal a dois, Log-N 3: Log-Normal a trés parametros, Log-P Ill =
Log-Pearson tipo Ill, G: Gumbel.
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A distribuicao Log-Pearson tipo Il obteve, em 100% dos casos, 0 menor erro padrao,
apresentando-se com o melhor ajuste aos dados de vazdo minima: Q7o (Tabela 5). Os
valores das vazbes minimas e médias (Qz10, Qoo, Qos € Qmeq) determinados para as
estacoes fluviométricas, utilizando os dados das séries histéricas de vazdes, sao

apresentados na Tabela 6.

Tabela 6 Vazdes minimas (m*s™), associadas ao periodo de retorno de 10 anos (Q; 1),
segundo a distribuicdo Log-Person Tipo lll, vazdes de 90 e 95 % de
permanéncia (Qg € Qgs) € vazdo média (Qmey), Obtidas para cada uma das
estacgdes fluviométricas da bacia do rio Piquiri

Vazées (m*s™)

Cédigo Estacao

Q7,10 Q90 Q95 Qmed
64764000 Guampara 4,48 11,57 8,90 53,80
64765000 Porto Paiqueré 6,31 16,47 12,78 81,06
64767000 Porto Carriel 7,45 15,76 12,42 108,71
64771500 Porto Guarani 6,69 19,00 12,50 120,50
64773000 Ponte Lebncio Primo 0,45 2,12 1,36 29,62
64775000 Balsa do Cantu 5,28 10,80 8,35 66,39
64776100 Foz do Cantu 17,70 36,31 28,25 219,35
64780000 Ponte Tourinho 1,42 2,45 1,90 6,47
64785000 Ponte do Goio-Bang 8,40 12,85 9,49 29,63
64790000 Salto Sapucai 6,31 5,74 4,80 17,83
64795000 Ponte do Piquiri 27,56 65,60 48,44 303,27
64799500 Novo Porto 2 28,15 75,59 54,04 360,37
64800000 Porto 2 34,08 70,89 56,92 253,63
64810000 Balsa do Goio-eré 15,53 21,27 19,48 45,40
64815000 Fazenda Uberana 19,82 30,75 26,76 61,31
64820000 Porto Formosa 72,70 129,36 108,33 419,96
64830000 Balsa Santa Maria 93,91 177,44 144,84 514,59
64833000 Ipora 8,89 11,42 10,97 19,01

Para as vazdes maximas, cerca de 70% dos dados das estagbes apresentaram o
menor intervalo de confianga, quando ajustados a distribuicdo Log-Normal a trés parametros
(Tabela 5). Desta maneira, a distribuigdo Log-Normal a trés parametros foi adotada de forma
padrao para a maioria, apenas para as estagbes 64765000 (Porto Paiqueré), 64771500
(Porto Guarani), 64785000 (Ponte do Goio-Bang), que nao obtiveram ajuste a Log-Normal a
trés parametros, utilizou-se a distribuicdo Log-Normal a dois parametros.

Os valores das vazdes maximas (Qmax2, Qmaxs Qmax10, Qmax25, Qmaxs0 € Qmax100)
associados a diferentes periodos de retorno, determinados para as estacodes fluviométricas,

utilizando os dados das séries histéricas de vazbes, sdo apresentados na Tabela 7.
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Tabela7 Vazdes maximas diarias (m® s™), associadas a diferentes periodos de retorno
(Qmax2: Qméaxs Qmax10, Qmex2s, Qmaxso € Qmax100), Obtidas apds o ajuste das
distribuicdes de probabilidade, para cada uma das estac¢des fluviométricas da
bacia do rio Piquiri

Vaz6es maximas (m? s'1)

Cédigo Estacéao

Qmax,2 Qmax,s Qmax, 10 Qmax,25 Qmax,50 Qmax, 100
64764000 Guampara 580,50 761,06 859,10 970,38  1046,17 1117,10
64765000 Porto Paiqueré 718,42 827,22 890,56 963,43  1013,63 1061,01
64767000 Porto Carriel 120569 1709,64 2091,66 2624,46 305582 3515,46
64771500 Porto Guarani 1414,01 166551 1919,77 2233,71 246324 268974
64773000 Eﬁ?r:g Ledncio 474,89 639,29 739,82 859,65 944,69  1026,77
64775000 Balsa do Cantu 821,04  1086,31 123519 1402,03 151443 1618,76
64776100 Foz do Cantu 3480,12 495145 578404 6722,61 7358,14 7950,24
64780000 Ponte Tourinho 5229 88,98 111,02 136,94 15515 172,58
64785000 Ponte do Goio-Bang 99,51 132,61 154,11 180,88 200,60 220,16
64790000 Salto Sapucai 82,52 132,28 164,22 203,65 23247 260,91
64795000 Ponte do Piquiri 2871,79 3681,26 4122,40 4606,50 4926,91 5220,40
64799500 Novo Porto 2 3614,56 4672,56 522929 582518 6211,33 6559,50
64800000 Porto 2 2143,39 3019,44 348516 3987,28 4314,67 4611,22

64810000 Bolsa do Goio-eré 150,37 192,67 217,44 246,07 265,86 284,59
64815000 Fazenda Uberana 211,37 295,51 351,79 423,39 477,07 531,04

64820000 Porto Formosa 2728,94 3627,27 410545 4621,47 4958,20 5263,38
64830000 Balsa Santa Maria  3003,97 3756,49 4222,63 4783,43 5184,60 5574,05
64833000 Ipora 44,44 55,43 61,68 68,77 73,59 78,09

5.2 Caracteristicas fisicas e climaticas

Na Tabela 8 s&o apresentados os valores das caracteristicas fisicas das 18
sub-bacias, utilizadas no estudo de regionalizagao.

Na obtencdo dos comprimentos totais dos rios das bacias, observou-se que, em
alguns locais, o modelo digital de elevagao (MDE) com resolugao de 30 metros, superestima
os valores dos mesmos, tendo em vista a quantidade de afluentes que foram delimitados,
interferiu na somatéria do comprimento total, tornando a rede de drenagem muito densa.
Como este parametro € muito influenciado pela resolucdo do mapa, a partir do qual o
mesmo é determinado, n&o foi possivel assegurar que os valores obtidos refletiam as reais
condicdes de drenagem das sub-bacias estudadas.

Os valores de precipitacdes médias obtidas para as bacias dos postos fluviométricos
considerados sao apresentados na Tabela 9. O mapa de isoietas da area de estudo é
apresentado na Figura 8: a) precipitacao total anual; b) precipitacdo do trimestre mais seco e

c) precipitacado do trimestre mais chuvoso.



35

Tabela 8 Caracteristicas fisicas das sub-bacias associadas as estagdes fluviométricas da
bacia do rio Piquiri

Densidade Declividade

A Comprimento . Declividade
Cadigo Nome Aref do rio principal de do_ rio média da
(km?) (km) drenag_zem prmmpj:l bacia (%)
(m.Km™?) (m.Km™)

64764000  Guampara 1687,5 1514 0,71 3,58 14,68
64765000  Porto Paiqueré 3281,0 248,2 0,72 2,71 17,18
64767000  Porto Carriel 3536,4 2611 0,72 2,64 17,38
64771500  Porto Guarani 4162,2 313,8 0,72 2,35 17,72
64773000  Ponte Ledncio Primo 754,6 73,8 0,69 7,08 20,09
64775000 Balsa do Cantu 2521,0 1844 0,69 3,61 16,62
64776100  Foz do Cantu 7649,7  359,3 0,71 2,15 17,28
64780000  Ponte Tourinho 274,3 34,8 0,63 7,14 10,71
64785000  Ponte do Goio-Bang 1335,3 134,1 0,64 3,46 8,64
64790000  Salto Sapucai 695,2 95,4 0,66 5,10 10,64
64795000  Ponte do Piquiri 11235,3 428,3 0,69 1,86 15,33
64799500  Novo Porto 2 12073,9 4446 0,69 1,81 14,83
64800000  Porto 2 13100,4 454,2 0,68 1,78 14,19
64810000  Bolsa do Goio-eré 2035,1 102,3 0,62 3,19 6,98
64815000  Fazenda Uberana 2957,5 143,0 0,62 2,61 6,92
64820000  Porto Formosa 17415,9 501,3 0,67 1,65 12,39
64830000 Balsa Santa Maria 20943,8 561,4 0,66 1,53 11,39
64833000 Ipora 1065,5 60,6 0,62 3,03 7,73
64764000 Guampara 1687,5 1514 0,71 3,58 14,68

Nota-se (Figura 8a) que a bacia do rio Piquiri apresenta um nucleo de chuvas cujos
valores anuais ultrapassam 2000 mm ano”', mas ha areas, ao norte da bacia, sujeitas a
precipitagdes variando de 1440 a 1700 mm ano™.

Correia (2013), em estudo realizado com 73 postos pluviométricos (41 postos
intrabacia e 32 postos extrabacia), com 35 anos (1976-2010), na bacia hidrografica do rio
Piquiri, observou que a distribuicdo anual média da precipitacdo em toda a extensao da
bacia varia entre 1400 a 2000 mm ano’, dados corroborados com os resultados
encontrados neste estudo.

A precipitagdo do trimestre mais chuvoso (Figura 8b) varia em torno de 580 a
890 mm trimestre™, os valores mais altos sdo observados no sul e sudeste. J& o trimestre
mais seco (Figura 8c) varia em torno de 155 a 290 mm trimestre™ e os valores menores séo
observados no norte e nordeste.

Nao se conseguiu achar padrédo em relagdo aos meses mais secos € mais chuvosos.
Segundo o IAP (2008), a bacia do rio Piquiri, situa-se em uma regido que apresenta aspecto
climatolégico tipicamente temperado, caracterizado por um regime de precipitacdo quase
equitativa ao longo do ano, ou seja, € quase impossivel pela climatologia prever a época ou
o trimestre do ano que as maximas e minimas concentracdes irdo se verificar, devido a

circulagao atmosférica.
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Tabela 9 Valores de precipitacado total anual, do trimestre mais seco e do trimestre mais
chuvoso, obtidos pelo método de interpolagcdo do quadrado médio da distancia
(IDW) das sub-bacias, associados as estacdes fluviométricas da bacia do rio
Piquiri
Precipitagdo total Precipitagéo_ Pfecipitagéo_do
Cédigo Nome anual trimestre mais trimestre mais
(mm ano'1) chuvo§o § seco p
(mm trimestre™) (mm trimestre )
64764000 Guampara 1902,3 766,3 243,8
64765000 Porto Paiqueré 1900,1 783,4 250,6
64767000 Porto Carriel 1901,4 783,5 250,0
64771500 Porto Guarani 1904,1 783,5 248,7
64773000 Ponte Lebncio Primo  1993,5 787,8 253,5
64775000 Balsa do Cantu 1952,9 777,8 242.3
64776100 Foz do Cantu 1918,2 779,9 2453
64780000 Ponte Tourinho 1889,1 800,5 2431
64785000 Ponte do Goio-Bang 1869,2 738,1 227,0
64790000 Salto Sapucai 1799,2 764,0 236,1
64795000 Ponte do Piquiri 1895,2 769,3 240,5
64799500 Novo Porto 2 1893,9 765,9 239,3
64800000 Porto 2 1883,1 758,6 236,3
64810000 Bolsa do Goio-eré 1719,0 668,7 188,2
64815000 Fazenda Uberana 1688,4 659,6 182,6
64820000 Porto Formosa 1837,4 734,3 223,3
64830000 Balsa Santa Maria 1824,3 723,8 218,7
64833000 Ipora 15632,9 620,2 165,5
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Total anual (@)
(mm/ano)

I 1.446-1.510
[ 1.510-1.574
[ ]1574-1638
[ ]1638-1.702
I 1.702-1.766
I 1.766 - 1.830
I 1.830-1.958
I 1958 - 2.022
I 2.022-2.086

Trimestre (b)
mais chuvo
(mm/trimestre)

[ 582-613
[ 613 -644
[ Je44-675
675 - 706
I 706 - 737
I 737 - 768
I 768 - 799
B 790 - 830
B 830 - 890

Trimestre (c)
mais seco
(mm/trimestre)

[ 155- 170
[ 170-185
[ ]185-200
[ ]200-215
B 215- 230
I 230 - 245
I 245 - 260
I 260 - 275
B 275 - 290

Figura8 Mapa das isoietas, referente a precipitagdo total anual (a), trimestre mais
chuvoso (b) e trimestre mais seco (c) para a bacia hidrografica do rio Piquiri.



